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Chapter 1: Introduction 

1.1   Background 
DoDTechipedia is the Department of Defense’s (DoD) enterprise-wide knowledge management platform 
designed for communication and collaboration among DoD scientists, engineers, acquisition 
professionals, warfighters, DoD employees, DoD contractors, federal government employees, and 
federal government contractors. 

 
Several DoD organizations are working together to develop, maintain, and govern DoDTechipedia, 
including the Under Secretary of Defense for Acquisition, Technology, and Logistics [USD(AT&L)], the 
Assistant Secretary of Defense for Research and Engineering [ASD(R&E)], Networks and Information 
Integration and Department of Defense Chief Information Officer (NII/DoD CIO), and the Defense 
Technical Information Center (DTIC), 

 
DoDTechipedia was launched in 2008 as a social software platform for the Department to facilitate 
collaboration and increase communication. In 2013, DoDTechipedia joined DTIC’s Research and 
Engineering (R&E) Gateway as the DTIC’s premier knowledge management tool. 

1.2   Purpose 
The purpose of this document is to provide DoDTechipedia users with an overview of the site, basic 
instructions, and tips for navigating and contributing to the wiki. 

1.3   Scope 
The scope of this user guide is to provide DoDTechipedia users with a reference document to assist in 
navigating and performing functions throughout the site. The guide provides users with basic and 
advanced function using the Confluence Editor. 
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Chapter 2: What is DoDTechipedia? 

2.1   DoDTechipedia is… 
DoDTechipedia is DTIC’s knowledge management platform, in which users can use the resources and 
features of DoDTechipedia to collect and store the information on which they need to collaborate or to 
generate collaboration. 
 
In this capacity, DoDTechipedia is the premier knowledge repository for the DoD’s S&T community’s 
collaborative research. Use DoDTechipedia as a repository for your completed research; publish what 
you know and have learned. Use others’ content to propel your research with new ideas and 
possibilities.  

2.2   DoDTechipedia is not… 
In accordance with DoDTechipedia’s content management strategy, DoDTechipedia is not: 

 A repository for terms and acronyms. Unless research relating to the defined term or acronym is 
provided, add your information to the DoDTechipedia dictionaries. 

 A place to test the editor. If you’re curious about new features or the editor, use your personal 
space or the DoDTechipedia sandbox to try new things. 

 A place to discuss opinions. DoDTechipedia collects fact-based knowledge; unless your opinion 
can be proved by research, use your personal space or your personal blog for discussing 
opinions. You may, however, speak freely about your opinion on an article using the comments 
if your statements contribute validly to the overall article and discussion. 

 A repository for links. If you must add a link, find related topics and share your links there, 
rather than to create new pages for only one link. Consider using browser bookmarks or your 
personal space to recall links to websites and webpages. 

 A place for announcements or solicitations, unless research or additional knowledge is provided 
or the solicitation is presented via the DoDTechipedia Forum. Contact DoDTechipedia’s Content 
Manager to post an announcement on DoDTechipedia’s home or menu pages. 

 A repository for formally-published documents such as journal articles or scholarly reviews. 
DoDTechipedia content may certainly reference these articles or feature informal versions of 
these works, but initial distribution of formally-published articles needs to occur in or be 
executed through the DTIC Collections. 

 
DoDTechipedia is not the preeminent collaborative platform at DTIC, though collaboration is possible via 
the DoDTechipedia communities. You may certainly use us for collaboration, but DoDTechipedia is more 
successful in knowledge management, serving as your repository by which collaboration is generated. 
 
Users are advised that content in DoDTechipedia violating the content management strategy, as 
outlined above, will be removed at the discretion of DoDTechipedia’s Content Manager and without 
notice to the user.  
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Chapter 3: General Wiki Page Features 
The following are features commonly found on all DoDTechipedia pages. 

3.1   R&E Gateway Header 
The R&E Gateway connects DoDTechipedia users to the DTIC Enterprise. 
 

 
Figure 1: R&E Gateway Header 

3.1.1   Enterprise Navigation 
 

 
Figure 2: Enterprise Navigation in the R&E Gateway Header 

The R&E Gateway Enterprise Navigation connects DoDTechipedia to its sister products at DTIC: 

 DoDTechSpace 

 Defense Innovation Marketplace 

 Budget  

 IACs 

 Services – Discover the services DTIC offers. 

 Search – Search DTIC’s collections and databases for documents and reports. 

3.1.2   R&E Gateway Masthead 
The R&E Gateway Masthead features the seals of the Department of Defense and of DTIC, and the R&E 
Gateway emblem. The current product the user is on is identified as part of the emblem. Selecting the 
masthead from any location in DoDTechipedia will return the user to the DoDTechipedia home page. 
 

 
Figure 3: R&E Gateway Masthead. Selecting this will always return you to the DoDTechipedia home page. 

3.1.3   My DTIC Account 
Users can sign into their DTIC account to update their DTIC profile. 
 

 

3.1.4   Log Out 
Log out of DoDTechipedia and the R&E Gateway. 
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3.1.5  Need Help 
Request help from DTIC service departments. 

 
Figure 4: Need Help Module Collapsed 

 
Figure 5: Need Help Module Displayed. Input your information into the required fields and submit your request. 

3.1.6   Search 
Search DoDTechipedia or the DTIC Collections. DoDTechipedia’s search is autocomplete and provides 
suggestions. 

 
Figure 6: DoDTechipedia Search 

 
Figure 7: Search Autocomplete with Prepopulated Content Suggestions 
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3.2   Classification Reminders 
Classification reminders (also referred to as Distribution Statements) are located at the top and bottom 
of each wiki page. The top banner contains information detailing what can and cannot be posted to the 
wiki. The bottom banner reminds users that only unclassified information should be posted. 
 

 
Figure 8: Classification Statement in the Header 

 
 

 
Figure 9: Classification Statement in the Footer 
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3.3   Page Title Block 
The page title block contains helpful information about the page. 
 

 
Figure 10: DoDTechipedia Page Title Block 

3.3.1   Breadcrumbs 
Breadcrumbs identify each DoDTechipedia page and the hierarchy of each page within the wiki. This 
feature is located above the page title block on each DoDTechipedia page. 

3.3.2   Page Title 
The page title. 

3.3.3  Added by/Last edited by 
Each wiki page contains the name of the user that initially added the page, the name of the user that 
made the last change to the page, and the date of the most recent change. 

3.3.4   Hover Profile 
The Hover Profile, which appears as an interactive popup when a user hovers over another user’s name, 
provides quick access to key information about other DoDTechipedia users, their User Profile features, 
and network functions. 

 
Figure 11: The Hover Profile, which appears when you hover over another user's name. 

 

Breadcrumbs 

Page Title 

Added By/Last Edited By 
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3.4   User Options 
DoDTechipedia users have four buttons that represent what users can do with the content. These 
buttons are located in the upper right corner of each wiki page under the navigation menu. 
 

 
Figure 12: User Options for Working in DoDTechipedia 

3.4.1   Edit 
Selecting “Edit” will open the DoDTechipedia editor. (The editor is discussed beginning on page 28.) 

3.4.2   Watch 
Selecting “Watch” will allow users to receive notifications of any changes made to the designated wiki 
page. When a user creates and publishes a new page, a watch is automatically set to the page. 
 
By default, publishing changes to a page will automatically notify watchers of the edits. Editors can opt 
to disallow notifying the watchers in the Editor’s save toolbar. 
 
Users have the option to choose whether to watch the specific page or to watch all pages in the current 
space when selecting “Watch.” To remove a watch, users should select the “Watch” button of the 
specific page desired and deselect the appropriate checkbox in the popup. 

3.4.3   Share 
From the “Share” button, a popup box appears that allows users to send messages to other registered 
DoDTechipedia users with page links. It is not yet known if this application facilitates email and 
messages to non-DoDTechipedia users via email. 

 
Figure 13: Sharing pages on DoDTechipedia 
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3.4.4   Tools 
From the “Tools” dropdown menu, users can choose to make a page a favorite, print, view mark-up, 
export the page content to Word or PDF, view the page in DoDTechipedia’s hierarchy, apply restrictions 
if desired, and access keyboard shortcuts. 

 
Figure 14: Tools Dropdown Menu for Advanced User Options 

 
Please note that Space Operations and Space Admin and/or Confluence Admin, User Management, and 
Add-Ons are only available if you have Space Administrator and/or Confluence Administrator 
permissions. Most users will not. For more information on Space and/or Confluence Administrator 
permissions, contact dodtechipedia@dtic.mil.  
 
 

mailto:dodtechipedia@dtic.mil
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3.5   Comment Block 
Each page has a comment block, which incorporates several different features located at the end of the 
page content. 
 
 
 
 

 
Figure 15: Comment Block 

 

3.5.1   Labels 
Clicking on the label icon or text will allow users to add labels that describe the information on the page. 
Labels can also be added via the Editor module or by selecting L on the keyboard while viewing the page. 

3.5.2   Like 
Click the Like button to let people know that you agree with or enjoy a page, blog post, or comment. 
Click Unlike to remove your name from the list of people who like the content. 

3.5.3   Child Pages 
The child page counter displays how many children the current page has. Selecting the child page 
counter opens a list of the child pages’ page titles to facilitate navigation and browsing. 

3.5.4   Comments 
Comment on pages and blog posts, or respond to previous comments. Comments are displayed in 
chronological order so that newest comments are at the bottom of the page. 
 
Users have the option to become page watchers when they add a comment. Comments by the original 
page author are annotated with an “author” tag. 

Labels Like 

Comments 

Child Pages 
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3.6   R&E Gateway Footer 
The R&E Gateway Footer contains DTIC’s address and important links to DTIC policies, including 
Freedom of Information Act content, privacy, security, copyright, Section 508 accessibility, disclaimers, 
and guidelines. 
  
DoDTechipedia users will also be able to anonymously submit feedback to DTIC on our products and 
services and their experience using DoDTechipedia through the R&E Gateway Footer’s Feedback button. 
 

 
Figure 16: DoDTechipedia Footer 
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Chapter 4: Navigation 
The DoDTechipedia home page will launch users into their DoDTechipedia experience. The home page 
features dynamic images that show latest DoD research being studied, produced, and discussed in the 
news media.  
 

 
Figure 17: DoDTechipedia Home Page (https://www.dodtechipedia.mil) 
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4.0.1   DoDTechipedia Menu 
Navigating around DoDTechipedia is facilitated by the horizontal menu located between the page title 
block and the R&E Gateway header in the blue banner. The five menu links represent five main areas 
within DoDTechipedia. 
 

 
Figure 18: DoDTechipedia Navigation 

 
The first option, available on the menu’s left, is the user dashboard. This is represented by your first 
name in the menu. See Section 4.1 for more information on the User Dashboard. 
 
Reference is the encyclopedic content in DoDTechipedia, or the wiki. See Section 4.2 for more 
information. 
 
Community is the collaborative environment in DoDTechipedia, populated by user-requested and user-
administered communities. See Section 4.3 for more information. 
 
Support is the help area in DoDTechipedia, where users can find more resources, frequently asked 
questions, training, release notes, and the DoDTechipedia Sandbox. See Section 4.4 for more 
information. 
 
Create is how DoDTechipedia users add pages and content to DoDTechipedia. See Section 4.5 for more 
information. 
 
On page scroll-down view, the menu will change to reflect new features. The page scroll-down view of 
the menu will be fixed to the top of the browser window to facilitate navigation and browsing. 
 

 
Figure 19: DoDTechipedia Navigation on Page-Down View 

DoDTechipedia branding (the name and logo) will appear to the left of the user name. Selecting this will 
return users to the main DoDTechipedia homepage. 
 
Future work anticipated to the menu will include adding Search. Search is a dynamic menu option that 
will appear only when users have scrolled down the page past the R&E Gateway header. DoDTechipedia 
users can use this option to search for more content in DoDTechipedia or in the DTIC Collections without 
having to scroll to the top of the page. See Section 4.6 for more information.



Chapter 4 – Navigation 

DoDTechipedia User Guide v5.0 | 18  
 

4.1   User Dashboard 
Clicking on the user name takes the user to the user dashboard. There are three activity zones on the 
user dashboard, representing five different user activities. 

 
Figure 20: User Dashboard. Please note the R&E Gateway Header, the DoDTechipedia menu, and the Footer have been 

removed to show the entire User Dashboard page. 

4.1.1   Menu Dropdown 
Hovering over the user’s name in the main menu bar yields a dropdown of user options. This provides 
the user with links to update their status, create or view their personal space, see the pages and activity 
they have recently viewed or accomplished, and access their profile and network. 

4.1.2   My Favorites 
The user’s list of favorited pages within DoDTechipedia. 

4.1.3   My Watches 
The user’s list of watched pages within DoDTechipedia. 

4.1.4   My Community Updates 
All recent activity in DoDTechipedia. 

4.1.5   My Information 
The user’s profile information. 

4.1.6   My Activity 
The user’s activity in DoDTechipedia, across all visits and log-ins. 
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4.2   Reference 
Clicking on “Reference” takes the user to the “encyclopedic” content of DoDTechipedia’s wiki. This area 
of DoDTechipedia focuses specifically on the wiki articles that users may reference for their research or 
to support collaborative endeavors. There are three activity zones: the menu dropdown, content 
categories by which the articles are organized, and reference research tools. 

 
Figure 21: Reference -- Please note that the R&E Gateway, DoDTechipedia menu, and the Footer have been removed from 

this screenshot. 

4.2.1   Menu Dropdown 
Hovering over “Reference” in the main menu bar yields a dropdown of user options. These links 
correspond to the links available on the main “Reference” launch page. 

4.2.2   Content Categories 
The sixteen content categories represent the main subjects by which the articles published in 
DoDTechipedia discuss.  These categories may also reflect research goals of the Department of Defense. 

4.2.2.1   Defense Technology Areas 
A page that discusses the content available in DoDTechipedia and in DTIC’s collections about the 
Defense Technology Areas. 

4.2.2.2   Blogs 
Portal to the different types of blogs found on the wiki. All users have the ability to create their own 
personal blogs in their personal spaces in the user dashboard. If users want to have a non-personal blog, 
they must request the blog from DoDTechipedia Administrators. 
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4.2.2.3   News and Events 
Portal to content in DoDTechipedia that discuss or feature DoD efforts and initiatives in the news on 
various R&E and S&T topics and related events such as conferences and meetings. 

4.2.2.4   Organizations 
Portal to DoD research organizations, affiliated academic institutions, DoD contractor organizations, and 
other related government organizations that support the S&T, acquisition, and/or R&E communities. 

4.2.2.5   Countries 
Portal to bibliographies and content discussing DoD efforts and initiatives in other countries, with 
particular emphasis on countries in which the U.S. and/or the DoD is currently engaged. These 
bibliographies contain references to reports within DTIC’s Collections. 

4.2.2.6   Defense Research 
Portal to DoDTechipedia articles and content featuring Defense-sponsored research. In particular, these 
pages discuss the value of Defense-sponsored research, provide overviews on Defense research 
initiatives that may be in progress, or identify resources used to assist in newsgathering. Topics include 
Armed with Science podcasts, arctic resources, military spinoffs, and awards for research sponsored by 
the DoD, such as Nobel prizes and patents. 

4.2.2.7   Energy 
Portal to DoDTechipedia articles and content discussing energy and power. Topics include energetic 
materials, expeditionary energy, energetic weapons, and dark energy. 

4.2.2.8   Human Systems 
Portal to DoDTechipedia articles and content featuring information about human systems. Topics 
include human performance, models of human  behavior, and behavior modeling. 

4.2.2.9   Concepts of Change 
A page that discusses Mr. Shaffer’s R&E strategy for a future-thinking and innovative Department of 
Defense. Each new R&E strategy shows related content in DoDTechipedia, in DTIC’s collections, and in 
general news media. 

4.2.2.10   Information Systems 
Portal to DoDTechipedia articles and content discussing information systems and related computer 
technologies. Topics include information assurance and operations, networking, critical infrastructure 
protection, data, semantic web, and cloud computing. 

4.2.2.11   Logistics and Support 
Portal to DoDTechipedia articles and content discussing logistics and support efforts/initiatives for 
deployed warfighters. Topics include battlefield trauma management, fatigue management, situational 
awareness, weaponry, soldier baggage and burden, physical readiness, and warfighter physiology. 

4.2.2.12   Materials 
Portal to DoDTechipedia articles and content discussing materials and materials science. Topics include 
advanced electronics, advanced and composite materials, engineered materials, and rare earth 
minerals. 
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4.2.2.13   DoD Programs 
Portal to DoDTechipedia articles and content discussing Defense Programs. Programs can be historical or 
legacy, on-going, or future planned. These programs include military firefighting, small business, military 
working dogs, environmental cleanup, quality assurance, acquisitions and the services’ S&T strategies. 

4.2.2.14   Science 
Portal to DoDTechipedia articles and content discussing scientific research and/or scientific knowledge. 
Topics include cyber science, basic science, foundational science, medicine, nanoscience, and STEM 
(Science, Technology, Engineering, and Mathematics) communities. 

4.2.2.15   Strategy 
Portal to DoDTechipedia articles and content discussing Defense strategies for missions, research, 
and/or supporting the warfighter. Topics include anti-submarine warfare, DoD capabilities, cyber 
defense, electronic warfare, open government, and the department’s S&T Priorities. 

4.2.2.16   Technology 
Portal to DoDTechipedia articles and content discussing non-computer and non-information 
technologies. Topics include aviation technology, communications technology, engineering technology, 
naval technology, ground technology, RADAR technologies, and unmanned systems. 

4.2.3   Research Reference Tools 

4.2.3.1   Inside DoDTechipedia 
A blog by the DoDTechipedia Team and/or DTIC staff that discusses and highlights activities behind the 
scenes of DTIC and DoDTechipedia and may also feature new S&T articles and ongoing DoD research. 
The module features excerpted information. All users have access to read and comment on Inside 
DoDTechipedia blog posts, but cannot create blog posts unless authorized by DoDTechipedia 
administrators. 

4.2.3.2   DoDTechipedia Activity 
Recent activity within the Reference area of DoDTechipedia. 

4.2.3.3   Need More? 
Links the user can access for more information or research tools, such as the DoDTechipedia 
dictionaries, URED and Technical Reports collections, reference assistance, journal databases, and the 
DoDTechipedia forum. 
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4.3   Community 
Clicking on “Community” takes the user to the collaborative communities within DoDTechipedia. This 
area of DoDTechipedia focuses specifically on the user-requested and user-administered communities. 
There are five activity zones: the menu dropdown, Defense Communities, IACs, announcements, and 
Other Communities. 

 
Figure 22: DoDTechipedia Communities. Please note that the R&E Gateway, DoDTechipedia menu, and the Footer have been 
removed from this screenshot. 

4.3.1   Menu Dropdown 
Hovering over “Community” in the main menu bar yields a dropdown with community links. Selecting 
one of these links will take the user to the community access points. 

4.3.2   Defense Communities 
A list of all Defense Communities and their corresponding space administrator from whom users can 
request access. Selecting a Defense Community will take the user to the community in DoDTechipedia 
Defense Communities, a separate wiki for DoD employees and DoD contractors only. DoDTechipedia 
Defense Communities is CAC-accessible only. 
 
Note: While all users will see all community names and corresponding administrators, they will only be 
able to access and connect to the Defense Communities for which they have previously been approved. 
If a user selects a community to which he or she does not have access, the user will see an error 
message indicating the lack of approval for access. 

4.3.3   IACs 
A list of all IAC (Information Analysis Center) communities and pages to highlight their contributions to 
DoD, DTIC, and DoDTechipedia. 
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4.3.4   Community Announcements 
Announcements specifically relating to the DoDTechipedia Communities that include how to request a 
new community be set up, how users can request access to a community, as well as any user-requested 
maintenance alerts. 

4.3.5   Other Communities 
A list of non-Defense Communities. These communities can be accessible without a CAC. 
 
Note: While all users will see all community names and corresponding administrators, they will only be 
able to access and connect to the DoDTechipedia Communities for which they have previously been 
approved. If a user selects a community to which he or she does not have access, the user will see an 
error message indicating the lack of approval for access. 
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4.4   Support 
Clicking on “Support” takes the user to the section of DoDTechipedia that focuses on providing links to 
all major support and help topics. There are two activity zones: the menu dropdown and the support 
topics. 

 
Figure 23: Support Center. Please note that the R&E Gateway, the DoDTechipedia menu, and the Footer have been removed 
from this screenshot. 

4.4.1   Menu Dropdown 
Hovering over “Support” in the main menu bar yields a dropdown with links to the main support 
categories available. These are non-inclusive, but represent the major areas typically requested for user 
support and assistance. 

4.4.2   Support Topics 

4.4.2.1   DTIC 
Access information about DTIC and DTIC’s mission to support the warfighter and protect the homeland. 

4.4.2.2   Policies 
DoD, DTIC, and DoDTechipedia policies regarding security, web accessibility, privacy, posting 
information, and best practices. 

4.4.2.3   Government A-Z  
An alphabetical directory of all federal government resources and services, including links to other U.S. 
government websites . 

4.4.2.4   Acquisition Resources 
A portal to DoD Acquisition resources. Users may need to separately register or log-in for some 
websites. 

4.4.2.5   DoD Resources 
Related resources in the Department of Defense, not hosted at or by DTIC. 
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4.4.2.6   DoDTechipedia Knowledge Center 
Frequently asked questions, DoDTechipedia dictionaries, and how-to articles for using and working in 
DoDTechipedia. 

4.4.2.7   Training 
Training opportunities for users, including self-guided tutorials, offered by DTIC on DTIC products and 
services, including individual DTIC applications and the R&E Gateway. 

4.4.2.8   Coming Soon 
A page where users can see what DTIC and the DoDTechipedia team has planned for DoDTechipedia. 
Users will be able to recommend and vote for new features. 

4.4.2.9   Release Notes 
Release notes for prior DoDTechipedia upgrades and Confluence releases. 

4.4.2.10   Sandbox 
DoDTechipedia’s playground to experiment with Confluence and new DoDTechipedia features, if users 
do not want to use their personal spaces.  
 
Note: Content is periodically removed from the sandbox. 

4.4.2.11   Atlassian Confluence Documentation 
Link to connect users to Atlassian Confluence’s documentation center for straight-from-the-source 
support and information. 
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4.5   Create 
Selecting “Create” will activate DoDTechipedia’s new “add page” popup module. Users will be able to 
add pages from pre-existing templates if so desired. In the communities, administrators may choose to 
develop their own page templates for their users. 
 

 
Figure 24: Creating New Content on DoDTechipedia. The "Create" module, in which users select which page template they 
would like to use for their new page/content. 
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4.6   Search 
When users scroll down the page, the R&E Gateway will disappear and the DoDTechipedia menu will 
appear fixed to the top of the page. Only on a scroll-down view, the Search tab will appear. It replicates 
the same functionality of the R&E Gateway search, providing users with a search query field and toggle 
options to search DoDTechipedia or the DTIC Collections. 
 
Please note that this is an anticipated future enhancement to DoDTechipedia, expected to be released 
April 2014.
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Chapter 5: Working in DoDTechipedia 

5.1   Adding Pages 
Position yourself on the page you wish to add a page to and click “Create” in the menu bar. After 
selecting the template you wish to use, a new page will appear in edit mode. Type in a title for the page 
in the field that says “New Page” and add text in the text box below the formatting toolbar. 
 

5.2   Editing Pages 
The edit mode allows you to make changes to the content of a page, add graphics, add tables, et cetera. 
To edit a page, access the page you wish to edit and click on the “Edit” button in the right corner of the 
page. 
 

 
Figure 25: Selecting "Edit" 

 

 
Figure 26: DoDTechipedia Editor
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5.3   Working with the Editor 

5.3.1   The Formatting Toolbar 
When using the editor, you have access to a formatting toolbar containing a number of functions similar 
to other word-processing programs that allow you to format text and add characters, graphics, and 
tables to the page. 
 

 
Figure 27: DoDTechipedia's Editor Toolbar 
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5.3.2   Formatting Text 
 

 
 
Options available for formatting text include: 

 Headings: Use to create different heading levels within text. Use of headings will also generate 
the table of contents if the macro is added. 

 Bold: Bold text 

 Italicize: Italicize text 

 Underline: Underline text 

 Text Color: Change the text color 

 Additional Text Formatting 
o Superscript 
o Subscript 
o Strikethrough 
o Monospace 
o Clear Formatting 

 Bulleted Lists: Create bulleted lists 

 Numbered Lists: Create numbered lists 

 Task Lists: Create tasklists. Tasklists can be updated (i.e., tasks marked as complete) on “view” 
mode without opening the editor. 

 Left align: Align text to page left. If selecting “left align” with an image, the text will appear 
around the left of the image. 

 Center: Align text or graphics to the center of the page or section. 

 Right align: Align text to page right. If selecting “right align” with an image, the image will appear 
in line to the right of the text. 

 Sections: Create sections to organize your content and change your page layout. Use one layout 
template, or mix a combination. 

 
Note: Using general keyboard shortcuts (like CTRL+B or asterisk-space) that users might use in word 
processors will also work in the DoDTechipedia editor. See 6.8 for more on keyboard shortcuts. 
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5.3.3   Inserting Hyperlinks 
 

 
 
You can hyperlink text or graphics on a page to link to other pages within the wiki and to external sites. 
To add a hyperlink to your content, click the link button. 
 
Note: Using the general keyboard shortcut, CTRL+K, will also prompt the link popup to appear. 

5.3.3.1   Internal Hyperlinks 
To create links to pages within DoDTechipedia, highlight the text or graphic that will be the hyperlink. 
Click on the Insert Link button in the toolbar. In the popup, type the name of the page you want to link 
to in the query field. The search is autocomplete and should prompt you with matching suggestions. 
Select the appropriate page and click “Insert.” 
 

 
Figure 28: Module Pop-up to Insert DoDTechipedia-Internal Links 

5.3.3.2   Attachments 
To create links to your page’s attachments, highlight the text or graphic that will be the hyperlink. Click 
on the Insert Link button in the toolbar. In the popup, select “Attachments” from the link menu. Click on 
the appropriate attachment file and select “Insert.” 
 

 
Figure 29: Module Pop-up to Insert Link to Page Attachments 
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75.3.3.3  External Hyperlinks 
To create links to sites or webpages outside DoDTechipedia, highlight the words you want to hyperlink. 
Click on the Insert Link button in the toolbar. In the popup, select “Web Link” from the link menu. Paste 
or type the appropriate URL or email address into the field and select “Insert.” 
 

 
Figure 30: Module Pop-up to Insert Links to External Websites and Webpages 
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5.3.4   Inserting Tables 
 

 

 

5.3.4.1   Adding a Table 
To insert and format a table, select the table dropdown. Drag your cursor to the size of your table in 
order to add the table to the page. To add a table without a header row, press and hold SHIFT while 
sizing the table. 
 

 
Figure 31: Adding a Table via Drag-and-Click 

 
A table formatting toolbar will appear once the table has been added to the page, as indicated below. 
 

 
Figure 32: Table Formatting Toolbar 

5.3.4.2   Formatting a Table 
Options for formatting the table are: 

 Add/Delete Row 

 Copy/Paste text, table, row, or column 

 Add/Delete Column 

 Merge/Unmerge table cells 

 Add a Header Row 

 Add a Header Column 

 Change the Header Color 

 Remove Table 
Standard text formatting options (headings, colors, alignment, and lists) will work inside table cells. 
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5.3.4   Insert Dropdown 

 
 
Use the insert dropdown to insert links, graphics, special characters, and macros. The dropdown displays 
as indicated below. 
 

 
Figure 33: "Insert" dropdown menu options 

 
Options from the “Insert” dropdown: 

 Insert Image: Add a graphic to your page content. 

 Insert Link: Add a hyperlink to your content. 

 Insert Symbol: Insert a symbol or special character. 

 Insert Emoticon: Add emoticons to your content. 

 Insert Wiki Markup: Insert text via a popup window that allows you to add text in bulk using wiki 
markup. The editor will also convert wiki markup text input directly into the editor as it is 
written. 

 Insert a Horizontal Line: Insert a horizontal line within the text to create sections or divisions. 

 Insert a Tasklist: Create a tasklist for your content. 

 Insert macros: Insert macros, or browse through the macro menu (“Other Macros”) to enhance 
your content. 
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5.3.5   Undo/Redo 
 

 
 
Use these buttons to undo changes or to redo something accidentally deleted. 
 
Note: Using general keyboard shortcuts, CTRL+Z (undo) and CTRL+Y (redo), will also work in the editor. 
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5.3.6   Find/Replace 
 

 
 
Use this button to find and replace text within your content. Selecting it will yield the find/replace menu 
in the formatting toolbar, as indicated below. 
 

 
Figure 34: Find and Replace Formatting Toolbar 
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5.4   Adding Attachments 
In DoDTechipedia, you can add attachments, graphics, presentations, documents, or short videos to any 
wiki page. There are five ways to add attachments to a page. 

5.4.1   Add Attachment via Attachments module 
When in “view” mode of the page onto which you want to add an attachment, select (if available) the 
paperclip underneath the DoDTechipedia logo next to the add/last edited feature in the page title block. 
It will open the Attachments page, to which you can add attachments via the Browse Desktop button. 
 

 
 

5.4.2   Add Attachments via the Attachments page 
When in “view” mode of the page onto which you want to add an attachment, select the “Tools” 
dropdown and then select “Attachments.” It will open the attachments page, to which you can add 
attachments via the Browse Desktop button. 
 

 
Figure 35: "Attachments" in the Tools Dropdown Menu 

 

5.4.3   Add Attachments via the “Link” button. 
See page 32 for instructions. 

5.4.4   Add Attachments via the “Insert” Dropdown 
Add attachments via the “Insert” menu dropdown, as discussed on page Y, while in edit mode. 
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5.5   Embed Graphics 
To embed a graphic into a wiki page, click “Edit.” Place the cursor where you want the graphic to 
appear, and select “Image” from the “Insert” dropdown on the editor toolbar.  
 

 
Figure 36: Inserting an Image via "Insert" Dropdown 

 
A module to attach or select previously-attached graphics will appear, as indicated below. 
 

 
Users can opt to upload the graphic via the browse button, upload the graphic via web URL, or to search 
for the graphic on another DoDTechipedia page. Select “Insert” when finished. The graphic will appear 
on the page. 

5.5.1   Formatting Graphics 
When a graphic is inserted into the page content, a graphic formatting toolbar will appear as a popup 
over the page next to the image, as indicated below. 
 



Chapter 5 – Working in DoDTechipedia 

DoDTechipedia User Guide 5.0 | 39  
 

 
Figure 37: Graphics' Formatting Toolbar 

 

5.5.1.1   Resize Graphic 

 
 
Resize the graphic by editing the pixel size manually or selecting a pre-formatted size (small, medium, 
large, or original size). 

5.5.1.2   Add a Border 

 
 
Add a border to your graphic. 

5.5.1.3   Link to the Graphic 

 
 
Use your graphic to link to other DoDTechipedia content, attachments, email addresses, or general 
websites and webpages. 

5.5.1.4   Add Image Properties 

 
 
Change the way your graphic displays by adding advanced formatting. 
 

 
Figure 38: Image Effects 

      
Figure 39: Add Properties for Screen Readers 
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5.7   Macros 
Macros allow users to implement “advanced” formatting options, such as banners, insert charts, and 
view-file options.  The macros discussed here are neither exhaustive nor inclusive, but simply represent 
the most-frequently used macros by the DoDTechipedia user community. To access the macro menu, 
select “Insert” from the editor formatting toolbar, and then select “Other Macros” from the dropdown 
choices.  

 
Figure 40: Macro Menu 

 
On the macro menu, users can browse through the available macros or simply search via keyword query 
for the macro desired. The macro titles are indicated next to the reference number (5.7.x) in the 
following discussion. 
 
Note that for all macros allowing user-input text into the macro box, all text formatting options can be 
used. 
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5.7.1   Attachments 
Use the Attachments macro to display a list of the page’s attachments directly on the page. This macro 
also provides another option for users to upload attachments. 
 

 
Figure 41: Attachments Macro Menu 

 

 
Figure 42: Attachments Macro in Edit Mode 

 

 
Figure 43: Attachments Macro in View Mode 
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5.7.2   Children Display 
Use the Children Display macro to display a list of the page’s child pages. Users can choose whether to 
allow further descendants (i.e., a child page’s child pages). 
 

 
Figure 44: Child Display Macro Menu 

 

 
Figure 45: Child Display Macro in Edit Mode 

 

 
Figure 46: Child Display Macro in View Mode 
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5.7.3   Expand 
Use the Expand macro to show/hide additional descriptive text. Users can change the linked text that 
will trigger the show/hide. Add the macro to the page, and type the show/hide text into the macro box. 
 

 
Figure 47: Expand Macro Menu 

 

 
Figure 48: Expand Macro in Edit Mode 

 

 
Figure 49: Expand Macro in View Mode (Text Collapsed/Hidden) 

 

 
Figure 50: Expand Macro in View Mode (Text Displayed/Shown) 
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5.7.4   Highlight 
Use the Highlight macro to highlight text on your page. 
 

 
Figure 51: Highlight Macro Menu. 

 

 
Figure 52: Highlight Macro in Edit Mode 

 

 
Figure 53: Highlight Macro in View Mode 
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5.7.5   Info 
Call attention to certain information by using the Info macro, which creates a blue-bordered box on your 
page. Add the macro to the page, and insert the important information into the macro box. 
 

 
Figure 54: Info Macro Menu 

 

 
Figure 55: Info Macro in Edit Mode 

 

 
Figure 56: Info Macro in View Mode 
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5.7.6   Note 
Call attention to certain information by using the Note macro, which creates a yellow box on your page. 
Add the macro to the page, and insert the important information into the macro box. 
 

 
Figure 57: Note Macro Menu 

 

 
Figure 58: Note Macro in Edit Mode 

 

 
Figure 59: Note Macro in View Mode 
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5.7.7   Office PowerPoint 
Embed your Microsoft PowerPoint presentation directly onto your page and allow users to view the 
slideshow without directly opening the attachment. You must have a Microsoft PowerPoint file attached 
to the page in order for the macro to work. 
 

 
Figure 60: Office PowerPoint Macro Menu 

 

 
Figure 61: Office PowerPoint Macro in Edit Mode 

 

 
Figure 62: Office PowerPoint Macro in View Mode 
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5.7.8   Office Word 
Embed your Microsoft Word document directly onto your page and allow users to read the document 
without directly opening the attachment. You must have a Microsoft Word document attached to the 
page in order for the macro to work. 
 

 
Figure 63: Office Word Macro Menu 

 

 
Figure 64: Office Word Macro in Edit Mode 

 

 
Figure 65: Office Word Macro in View Mode 
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5.7.9   Panel 
Display a block of text within a customizable panel. Users can designate the colors and style for the 
panel borders and backgrounds. 
 

 
Figure 66: Panel Macro Menu 

 

 
Figure 67: Panel Macro in Edit Mode 

 

 
Figure 68: Panel Macro in View Mode 
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5.7.10   PDF 
Embed your PDF document directly onto your page and allow users to view/read the document without 
directly opening the attachment. You must have a PDF document attached to your page in order for this 
macro to work. 
 

 
Figure 69: PDF Macro Menu 

 

 
Figure 70: PDF Macro in Edit Mode 

 

 
Figure 71: PDF Macro in View Mode 
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5.7.11   Table of Contents 
Insert a table of contents to provide readers with page navigation for your content. This macro only 
works if editors and authors have used page headings.  
 

 
Figure 72: Table of Contents Macro Menu 

 

 
Figure 73: Table of Contents Macro in Edit Mode 

 

 
Figure 74: Table of Contents Macro in View Mode. Notice that the text in headings (left) populate the links in the table of 

contents (right). 
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5.7.12   Tip 
Call attention to certain information by using the Tip macro, which creates a green box on your page. 
Add the macro to the page, and insert the important information into the macro box. 
 

 
Figure 75: Tip Macro Menu 

 

 
Figure 76: Tip Macro in Edit Mode 

 

 
Figure 77: Tip Macro in View Mode 
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5.7.13   Warning 
Call attention to warn or give notice about certain information by using the Warning macro, which 
creates a red box on your page. Add the macro to the page, and insert the important information into 
the macro box. 
 

 
Figure 78: Warning Macro Menu 

 

 
Figure 79: Warning Macro in Edit Mode 

 

 
Figure 80: Warning Macro in View Mode 
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Chapter 6: Advanced Features 

6.1   Permissions 

6.1.1   Space Permissions 
Space permissions are the general permissions a user can have in DoDTechipedia. These permissions 
determine the access settings of users in DoDTechipedia and are controlled by space (or community) 
administrators.  
 
Space permissions are as follows: 

 View: user can view this space's content, including the space's details, and its pages and news 
items (blog posts) 

 Pages: 
o Add – user may create and edit pages in this space. 
o Restrict – user may apply page-level restrictions. 
o Delete – user may delete pages in this space. 

 Blog: 
o Add – user may add and edit blog posts in this space. 
o Delete – user may delete blog posts in this space. 

 Comments: 
o Add – user may make comments in this space. 
o Delete – user may delete comments from this space. 

 Attachments: 
o Add – user may add attachments in this space. 
o Delete – user may delete attachments from this space. 

All DoDTechipedia users within DoDTechipedia proper (i.e., not in Defense or Other Communities) will 
be able to add and restrict content. Only government employees – DoD and Federal Government – are 
able to delete content. DoD and Federal Government contractors who need content removed must 
request the deletion from DoDTechipedia Administrators. 
 
DoDTechipedia users may be permissioned into communities within DoDTechipedia as part of a group or 
as an individual. If a user is assigned more than one permission (i.e., if a user has access to a community 
as an individual and as part of the DoD employee group), then the more powerful permission will 
prevail; if the user has more permissions as an individual than as a group member, then the user’s space 
permissions will default to the individual settings and vice versa. 
 
Space Administrators are advised to contact dodtechipedia@dtic.mil for a more detailed explanation of 
space permissions. 

6.1.2   Page Restrictions 
Page restrictions allow you to control who can view or edit individual pages in a space. To add or remove 
restrictions to a page you will need to have permissions to edit the page and 'Restrict' or 'Admin' 
permission in the space. 

mailto:dodtechipedia@dtic.mil
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6.1.2.1   About Page Restrictions  
Confluence permissions are hierarchical, so page restrictions will not override any space permissions for 
the user or group. For example, if you restrict viewing or editing a page to a user who does not have 
'view' permissions for the space, they will not be able to see the page, as the page level restrictions 
cannot override their space permissions. 
 
Some page restrictions are inherited. If you restrict viewing a page to a user or group, all children of that 
page will also be restricted to the user or group. Edit page restrictions are not inherited. 

6.1.2.2   Adding Restrictions to a Page 
You can restrict viewing a page or editing a page to a specific user or group.   

1. Go to the page and choose Tools > Restrictions. 
2. Choose Restrict viewing of this page or Restrict editing of this page. 
3. Enter part of user or group name, and then choose the appropriate user or group from the 

autocomplete drop down. You can add multiple users and groups.  
The page restrictions have now been applied: 

 Viewing the page is now restricted to the users and / or groups listed. All other users will not be 
able to view the page. Any children of this page will inherit the viewing restrictions.  

 Editing the page is now restricted to the users and / or groups listed. All other users will be able 
to view, but not edit, the page.  

6.1.2.3   Viewing the Current Page Restrictions 
Confluence displays a padlock icon on the byline when a page has current viewing or editing 
restrictions.  

 
Figure 81: Page Title Block of a Restricted Page. Note the padlock icon next to the attachments icon. 

To view the restrictions, choose Tools > Restrictions or the padlock icon in the page title block, as 
indicated above. The Page Restrictions dialog appears, listing the users and / or groups that have 
restrictions applied. 

 
Figure 82: Page Restrictions Module 

6.1.2.4   Removing Restrictions from a Page 
To remove restrictions from a page, choose Tools > Restrictions or the padlock icon in the page title 
block. Choose Remove next to each restriction you would like to remove.  
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6.2   Import Word Document 
The “Import Word Document” option allows users to import Microsoft Word documents directly into 
DoDTechipedia. To import a word document, access the page where you want the document to be 
located. Note that if users select pages that already have content, the original content will be replaced 
by the imported content. Users are advised to create new blank pages to minimize the risk of replacing 
content. 
 
In the Tools dropdown menu, select “Import Word Document.”  Browse your desktop to find the 
document and click “Next” to configure the page. Select the appropriate options, and then click 
“Import.” 

                 
Figure 83: Configuring the Imported Word Document 
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6.3   Reverting to a Page’s Previous Version 
Every page in DoDTechipedia has a history that users can view to see who has made changes and when 
those changes were made. Users also have the ability to revert pages to previous versions. To revert the 
page to a previous version, click “Page History” in the Tools dropdown menu. 

 
 
From the Page History, you can view a previous version of the page, compare versions, and/or choose to 
restore a version. To restore a previous version, simply find the appropriate version and click “Restore 
this version.” 
 

 
Figure 84: Revert the Page to a Previous Version, Page History 
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6.4   Finding People 
When viewing pages in the wiki, users may want to contact other contributors. To search for another 
user, type the user’s name in the search box (making sure the toggle is selected for DoDTechipedia). The 
search will provide an autocompleted list of pages, communities, attachments, and user names that 
match the query. Select the appropriate user from the autocomplete list. 
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6.5   Footnotes 
Sourcing information is important. While DoDTechipedia used to have a macro that automatically 
formatted footnotes, that macro is no longer available. A suitable workaround is to use superscript text 
formatting, as described below. 
 
To insert footnotes into a page or blog, type a numerical or special character following the quoted or 
paraphrased sentence. Highlight the character and select superscript from the text formatting 
dropdown in the editor toolbar. Add the footnote text or the citation to the bottom of the page. 
 

 
Figure 85: Paragraph text annotated with a footnote.  

 

 
Figure 86: The bottom of the DTIC page, showing the footnoted references. 
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6.6   Personal Spaces 

6.6.1   Setting up Personal Spaces 
All DoDTechipedia users have a personal space where they can create personal pages and a personal 
blog. To create a personal space, scroll over your user name in the menu and click on “Add Personal 
Space” in the dropdown.  
 
This action will yield a popup that explains how to use a personal space. Click “Create” on the popup. 
 

 
Figure 87: Want to create a personal space? Click "Create." 
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6.7   Removing Content 
Registered DoDTechipedia users who are DoD or Federal Government employees have the ability to 
remove content on DoDTechipedia. DoD or Federal Government contractors do not have the ability to 
remove DoDTechipedia content and must request removal from DoDTechipedia Administrators. 
 
Be sure that you delete only the content that belongs to you. Deleting other people’s content, without 
permission, may result in loss of the ability to remove content. 

6.7.1   Deleting a Page 
Access the page to be deleted. Click “Tools” and choose “Delete.” Confirm the action as prompted.  

 
Figure 88: Delete a Page 

If a page is deleted by mistake, contact the DoDTechipedia Administrators to have the page restored. 

6.7.2   Delete a Page Version 
Access the page history (see Tools > Page History). Choose “Delete” next to the version you want to 
delete. Confirm the action as prompted. 
 

 
Figure 89: Delete a Page Version 

A deleted page version is unrecoverable. Please ensure that the version being deleted is the correct 
version. 

6.7.3   Deleting a Blog Post 
Access the blog post to be deleted. Click “Tools” and choose “Delete.” Confirm the action as prompted. 
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Figure 90: Delete a Blog Post 

If a blog post is deleted by mistake, contact the DoDTechipedia Administrators to have the page 
restored. 

6.7.4   Deleting an Attachment 
Access the page that contains the attachment. Click “Tools” and choose “Attachments.” Select “Delete” 
next to the attachment you want to delete. Confirm the action as prompted. 
 

 
Figure 91: Delete an Attachment 

Deleted attachments are unrecoverable and cannot be retrieved by DoDTechipedia Administrators. 
Please ensure that the attachment you are deleting is the correct one and that, if necessary, a copy of 
the file has been saved to your desktop. 

6.7.5   Deleting a Comment 
Access the page containing the comment. Scroll down to the comment. Select “Delete” from the 
comment options. Confirm the action as prompted. 
 

 
Figure 92: Delete a Comment 

Deleted comments are unrecoverable and cannot be retrieved by DoDTechipedia Administrators. Please 
ensure that the comment you are deleting is the correct one. 
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6.8   Exporting Pages 
DoDTechipedia users have the ability to export DoDTechipedia pages and blog posts to PDF or Microsoft 
Word documents. To export, access the page or blog post desired. Choose “Tools” and select either 
“Export to PDF” or “Export to Word.” Select to open or save the file. 
 

 
Figure 93: Exporting Pages 

 
Please be advised of the following regarding page exports: 

 Exported pages with columns via the section options (from the editor; see 5.3.2) may not display 
columns properly and instead show the page content in one single column. 

 Only image attachments that have been inserted into a page are included in an export. 

 To export multiple pages in a single document, contact DoDTechipedia Administrators with your 
request and identify the pages or communities to be exported. 
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6.9   Keyboard Shortcuts 
All DoDTechipedia users can access the keyboard shortcuts menu via the Tools dropdown or press 
“Shift+?” on your keyboard. The keyboard shortcuts enabled are discussed below, as found in Atlassian 
Confluence’s main documentation. 
 

 
Figure 94: Keyboard Shortcuts in the "Tools" Dropdown 

Safari/Mac users, please substitute Control (CTRL) for Command (CMD), as indicated. 

6.9.1   All Screens 
The following keyboard shortcuts work on all screens across DoDTechipedia.  

Windows Action Mac OS X 

/ Enable the quick search / 

Ctrl+S Submit (where a form is active). 
Editor -- save the Confluence page. 
Outside the editor -- save the browser page. 

Cmd+S 

G then S Browse the current space G then S 

G then G Position cursor in the search box. G then G 

Shift+? Open the Keyboard Shortcut help Shift+? 
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6.9.2   Editor Shortcuts 
These are shortcuts to use while working in the editor. 

Windows Action Mac OS X 

[ then ] Start a list of tasks. More about tasks... [ then ] 
Ctr+0 Apply the paragraph style. Cmd+0 

Ctr+7 Apply the preformatted style. Cmd+7 

Ctr+8 Apply the block quote style. Cmd+8 

Ctr+(1–6) Apply a heading level (of the number chosen) to the current 
line. 

Cmd+(1–6) 

Ctr+I  
(letter I, not 
number 1) 

Make the selected text italic. Cmd+I 
(letter I, not 
number 1) 

Ctrl+B Make the selected text bold. Cmd+B 

Ctrl+K Insert a link. (Opens the Insert Link dialog.) Cmd+K 

Ctrl+M Insert an image. (Opens the Insert Image dialog.) Cmd+M 

Ctrl+S Save the page you are editing. Cmd+S 

Ctrl+Shift+A Open the Macro Browser. Cmd+Shift+A 

Ctrl+Shift+B Format text as a bulleted list. Cmd+Shift+B 

Ctrl+Shift+D Insert wiki markup. (Opens the Wiki Markup dialog.) Cmd+Shift+D 

Ctrl+Shift+E Preview the page you are editing. Cmd+Shift+E 

Ctrl+Shift+F Hide the tools at the top and bottom of the page, giving you 
a much larger editing area (a full-screen editor). 

Ctrl+Shift+F 
 

Ctrl+Shift+K See a list of suggested pages or other locations to link to 
from your page.  

Cmd+Shift+K 

Ctrl+Shift+M See a list of suggested images, documents and other files to 
embed in your page.  

Cmd+Shift+M 

Ctrl+Shift+N Format text as a numbered list. Cmd+Shift+N 

Ctrl+Shift+S Format text with a strike through. Cmd+Shift+S 

Ctrl+U Make the selected text underlined. Cmd+U 

Ctrl+Y Revert an action that was undone. Cmd+Y 

Ctrl+Z Undo the most recent action. Cmd+Z 

Shift+Enter Force a line break without a paragraph break. This is a line 
break with no extra space. 

Shift+Enter 

Shift+Tab 'Outdent' current line (only in bulleted lists and numbered 
lists). 

Shift+Tab 

Tab Indent current line (only in bulleted lists and numbered lists). Tab 

 
  

https://confluence.atlassian.com/display/CONF53/Managing+Tasks+in+Confluence
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6.9.3   Table Shortcuts 
These are shortcuts for working with tables in the editor. 

Windows Action Mac OS X 

Ctrl+Shift+c Copy the current table row, or the selected rows. Cmd+Shift+c 

Ctrl+Shift+i Insert a table. (Opens the Insert Table dialog.) Cmd+Shift+i 

Ctrl+Shift+v Paste the table rows from your clipboard, placing them 
above the current row. 

Cmd+Shift+v 

Ctrl+Shift+x Cut the current table row, or the selected rows. Cmd+Shift+x 

Alt+Up Arrow Add a row above the current row. Alt+Up Arrow 

Alt+Down 
Arrow 

Add a row below the current row. Alt+Down 
Arrow 

6.9.4   Autocomplete Shortcuts 
These are shortcuts to trigger autocomplete suggestions while working in the editor. 

Key Action 

! See a list of suggested images, multimedia files and documents to embed in 
your page. 

@ See a list of suggested users to mention. 

[ See a list of suggested pages or other locations to link to from your page. 

{ See a list of suggestions as you begin typing a macro name. 

6.9.5   View Shortcuts 
These are shortcuts to use while viewing (published) pages in DoDTechipedia. 

Windows Action Mac OS X 

B Create a blog post. B 

C Create a child page of your current page. C 

E Edit a page or blog post, or return to Edit mode when 
previewing. 

E 

K Open the Link To dialog. K 

L Add or edit labels. L 

M Add a comment to a page or blog post. M 

S Share the current page S 

T View attachments. T 

V Return to page view (only if you are viewing page 
attachments). 

V 

W Add or edit watchers. W 
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6.10   Drafts 
At regular intervals, the wiki automatically saves a draft of the page you are editing. If a network failure 
or a system error prevents you from saving your page, you can retrieve its last saved draft and continue 
working on the page where you left off. Each time a draft is saved, the editor is time-stamped with the 
time of the last save displayed near the “Save” button on the editor. 
 

 
Figure 95: Draft Autosave Message 

 
When a draft saves, it saves to your “Drafts” page in your user dashboard.  
 

 
Figure 96: Accessing Drafts 

 
Figure 97: Accessing a Saved Draft 

You can choose to view the changes you were making, continue editing the page, or to delete the draft. 
These options will also appear in a banner should a draft time out and not save or should someone 
editing the same page save before you were ready. 
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6.11   User Preferences 
Users can modify the settings to change how often they receive emails from DoDTechipedia and to 
disable or enable autocomplete or autoformatting in the editor. Users can update and change their 
settings as often as they desire. 

 
 

 
Figure 98: Editing Email Preferences. Click "Edit" to make changes. 
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6.12   DoDTechipedia Forum 
The DoDTechipedia Forum is a place where DoDTechipedia users can ask questions to or solicit research 
assistance from the general DoDTechipedia user community. To access the forum, search for “Ask 
DoDTechipedia” or go to “Reference” and select “Ask DoDTechipedia” from the “Need More?” panel.  

 
 

 
Figure 99: DoDTechipedia Forum 

The “Ask DoDTechipedia” page serves as the DoDTechipedia Forum. Users can view previously-asked 
questions and brief descriptions of the research effort on this page. Responses to the inquiries are 
indicated by the text bubble on the right side of the description (the number of responses is below the 
text bubble). To view a question and the community’s response(s), access the linked question text. 
 
To ask DoDTechipedia a question, select the “Ask DoDTechipedia a Question” button to access a form. 
Follow the instructions on the form to complete it and select “Save” to submit your question and publish 
it to the forum’s home page. 
 
For space administrators in Defense and Other Communities interested in duplicating this functionality 
to their targeted user community, please contact dodtechipedia@dtic.mil. 
 

mailto:dodtechipedia@dtic.mil
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Glossary 
Administration Console 
The Administration Console is the interface for the global administration of DoDTechipedia. Only 
administrators can access the Administration Console. 
 
Administrators 
DoDTechipedia and DTIC staff who have full administrative access to DoDTechipedia. 
 
Atlassian Confluence or Confluence 
The software powering DoDTechipedia. Confluence may be used to refer to DoDTechipedia or the 
DoDTechipedia development team at DTIC. 
 
Blog Posts 
A blog post may be a journal entry, status report or any other timely information pertaining to a space. 
 
Change Comment 
A change comment is a short description entered during the edit of a page to record the changes being 
made in the edit. 
 
Child Pages 
Creating child pages is a means of hierarchically organizing content in Confluence. A child page can only 
have one parent page. 
 
Comments 
A comment may be a remark, question, or any other additional information you wish to add to a page 
pertaining to the topic the page covers. You can comment on any page or news item in Confluence. 
 
Community 
A community is an area within DoDTechipedia, containing your pages, blog posts and other content. You 
can think of each community as a sub-site, or mini-site, each with its own home page. To create a non-
personal community, contact DoDTechipedia Administrators (dodtechipedia@dtic.mil). Communities 
are also interchangeably called “spaces.” 
 
Hover Profile 
The hover profile is the pop-up you see when the mouse pointer pauses over a Confluence user's name. 
Use the hover profile to follow the user, visit their profile, and more. 
 
Keyboard Shortcuts 
Keyboard shortcuts are combinations of two or more keys (on a keyboard) that can be used to perform 
a task that typically require a mouse. DoDTechipedia has enabled specific keyboard shortcuts, in 
addition to general text formatting keyboard shortcuts. To read more on keyboard shortcuts, see page 
65.  
 
Labels 
Labels are user-defined tag words assigned to pages to categorize content in Confluence. 
 
Macros 

mailto:dodtechipedia@dtic.mil
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A macro is a command wrapped inside curly braces {...} used to perform programmatic functions and 
generate more complex content structures in Confluence. 
 
Notifications 
A notification is an email message sent to you updating you of changes to pages and spaces you choose 
to 'watch'. 
 
Orphaned Pages 
An orphaned page is a page without any incoming links. 
 
Pages 
Pages are the primary means of storing information in Confluence and are the building blocks of spaces. 
 
Parent Page 
A parent page is a page that has one or more child pages. It may itself be a child of another page. 
 
People Finder 
The People Directory contains a list of all users in your Confluence site. Each user's name links to their 
personal space. 
 
Permalink 
A permalink is the URL used to link to specific content items like comments. 
 
Personal Spaces 
Personal spaces belong to users, and are accessible from the user dashboard. 
 
RSS Feeds 
An RSS feed is a format for delivering summaries of regularly changing web content. RSS is read by RSS 
newsreader programs. You will need an RSS reader to subscribe to feeds within DoDTechipedia and 
DoDTechipedia acts as an RSS reader for feeds from outside sites. 
 
RSS Reader 
An RSS reader is a specialized RSS program (also called aggregator) that displays the contents of RSS 
feeds for you. To subscribe to RSS feeds within Confluence, you will need an RSS reader. 
 
Space Administrators 
A space administrator is a user with the 'Space Admin' permission for the space. A user with this 
permission can perform a host of functions relating to the management of a space and has complete 
access to the space regardless of any other control settings or permissions. Permissions for a space are 
only assigned and modified by space administrators. 
 
Spaces 
A space is an area within DoDTechipedia, containing your pages, blog posts and other content. You can 
think of each space as a sub-site, or mini-site, each with its own home page. To create a non-personal 
space, contact DoDTechipedia Administrators (dodtechipedia@dtic.mil). Spaces are also interchangeably 
called “communities.” 
 
Templates 
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A template is a pre-defined page that can be used as a prototype when creating pages. Templates are 
useful for giving pages a common style or format. 
 
Thumbnails 
All images on the page that aren't links are displayed as thumbnails: when you click on an image the full-
size image is displayed in a pop-up. 
 
Tiny links 
A tiny link is the shortened URL of a page which is useful when sending links to the page, for example, 
via email. 
 
Undefined Links 
An undefined link is a link to a page that has not yet been created. Clicking on the page link allows you 
create the page. 
 
User Dashboard 
The dashboard is the user’s space in DoDTechipedia. It provides a general overview of the user’s activity 
in DoDTechipedia and displays a list of the most recently updated content within them. 
 
User Profile 
Every user account in Confluence is linked to a profile that contains user related information and options 
to configuring user preferences. 
 
Watching 
When you watch a page, you receive an email notification whenever that page has been 
modified. When you watch a space, you receive an email notification whenever content is added or 
modified in that space. 
 
Wiki 
Pioneered by Ward Cunningham, and named after the Hawaiian word for 'quick', a wiki is a website that 
makes it easy for anyone to contribute pages, and link them together. 
 
Wiki Markup 
This is the specialized markup formerly used to write and edit page templates. Specialized knowledge of 
wiki markup is no longer required to use DoDTechipedia, but users who wish to write in wiki markup 
may do so via the Wiki Markup macro. Users writing in wiki markup will not be able to edit their text in 
wiki markup once the initial macro is saved and applied to the page content.
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Please send your comments, corrections, suggestions, and requests for technical 
assistance to dodtechipedia@dtic.mil. 
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